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基本操作のおさらい



スペクトラム・アナライザ基本設定

中心周波数

スパン基準レベル

RBW

(分解能
帯域幅)

<設定値の変更方法>
変更したい設定値をクリック→ 数値を入力しEnterキーを押す、もしくは
PCキーボードのカーソル・キーやマウスのホイール操作でも変更可

Presetボタン
（設定を初期状態に戻す）

設定の
取り消し/
やり直しも
可能です
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測定画面の追加方法

Application Presetsで
代表的な表示を
一括ロードできます

Available dispalys: の中から、
画面に表示させたい項目を
クリックして”Add”ボタンをクリック、
あるいはダブル・クリック、
もしくはSelected displays:の
エリアへ直接アイコンを
ドラッグ＆ドロップします

Selected displays:の
エリアに、選択された
ウインドウが表示されて
いることを確認し、
“OK”をクリックします

選択可能な項目は
カテゴリ別に分類
されています

Displaysアイコンを
クリックし、出てきた
ウインドウから画面に
表示させる項目を
選びます

測定項目を削除する
場合は、このウインドウ
内のアイコンを
クリックして右の
“Remove”ボタンを
クリックするか、
ダブル・クリックをします
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標準搭載(オプションなしで使える)機能
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表示機能 ---
Amplitude vs Time, DPX, Frequency vs Time, 
Phase vs Time, RF I&Q VS Time, Spectrogram, 
Spectrum, Time Overview

測定機能 ---
CCDF, Chan Pwr and ACPR, MCPR, 
Occupied Bandwidth, SEM, 
Spurious

アナログ変調機能 ---
AM, FM, PM



設定ウインドウについて

アイコンをクリックすることで、画面下に
各測定・解析画面の設定ウインドウを
呼び出すことができます

フォーカスされているウインドウ（上部分の帯が青くハイライト
されているウインドウ、この図の場合はSpectrogram）の設定項目が
ここに表示されます

取り込み停止中、
あるいは保存されたデータの解析時に
変更した設定を反映させるためには、
最後に をクリックしてください
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 画面上部メニューバーより、File > Save 

As をクリック、あるいは アイコンを
クリックします

 以下の形式での保存が可能です。

 Setup: 設定の保存。

 Picture (PNG, JPG, BMP): 画面の保存。

 Results export (CSV): 直前にクリックした
画面の測定結果をCSV形式で保存します。
この形式で保存されたファイルを、後から
SignalVu-PCで解析することはできません。

 Measurement settings export (TXT): 

測定設定内容の保存。ASCIIファイルで変調
速度、フィルタなどの状態を保存。

 Acquisition data with Setup(TIQ):

取込データをバイナリ形式で設定データと
一緒に保存します。後からSignalVu-PCで
呼び出して解析が可能です。

 Acquisition data export (CSV, MAT): 取込
データの保存。IQデータをCSV形式または
Matlab形式で保存します。SignalVu-PC以
外のオフライン解析ソフトで解析する際に
使用します。

最重要

データのセーブ
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• 画面上部のメニューバーから
アイコンをクリック

• ファイル形式をTIQ

（MDOシリーズ、RSAシリーズ）
もしくはIQT(SAシリーズ、
RSA3000シリーズなど)

から選択

• ファイル名を選択して、
ダブルクリックもしくは”開く”を選択

• 出てきたウインドウから、
”Data and setup”を選んで”OK”をクリック

データの呼び出し

ファイル形式選択ファイル名選択
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• デモボードとの接続

1. 電源供給用
USBケーブルを
USB2.0ポートに接続する
(2つ)

2. BNCケーブルで、
RF OutputとRF Inputを
接続する

• デモボードの設定方法

1. 電源をONにする

2. INT / EXT をINT にする

3. FREERUNモードにする

4. ROWとCOLUMNの2つのボタンで
ランプの点灯位置を変え、
出す信号を決定する
（右写真ではCW信号が出力
されています）

RSAデモボードセットアップ手順
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標準機能



メモリ

時間

信号

トリガ

タイム・スタンプ

T1 T2 T3 T5T4

T1 T2 T3 T5T4

• トリガ、キャプチャ（取り込み）、表示、次のトリガ待ち
を繰り返す

• 比較的繰り返し速度が遅い信号や不規則に繰り返す信号の
情報を得るのに有益

1. トリガ機能
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• トリガ条件は、2種類から選ぶことができます

◦ RF Input （RF入力パワー・トリガ）：
入力信号のパワーの立上り/立下りでトリガをかけることができます

◦ External：
外部トリガ信号の立上り/立下りに同期した取込みを行います
複数の測定器間で取込みタイミングを同期させる際に有効です

1. トリガ機能
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• 画面右上の をクリックします

• （デモボードを使用する場合：”CW Pulse”ランプを点灯）

• 信号源に合わせて中心周波数・スパンを設定します
（デモボードの場合：中心周波数2.445312GHz, スパン40MHz）

• 画面上部の アイコンをクリックし、
“DPX”と”Time Overview”画面を追加し、OKをクリックします

• 画面上部の アイコンをクリックすると、
画面下部にTriggerメニューが出てきます

• Triggerメニュー左端の”Free Run”を、”Triggered”をクリックして変更します

• Eventタブにて、SourceがRF Input、SlopeがRiseになっていることを確認した後、
Level: の値を調整します。（デモボードの場合：-20dBm）
→Time Overview画面にトリガ・レベルが横線で表示されます

1. トリガ機能操作手順 1/2
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• Time Overview画面（プロットエリアの縦軸：振幅、横軸：時間）で、
Tのマークのところで信号のパワーが立ち上がっていることを確認します

• Time OverviewのAnalysis Lengthを変更します
（デモ・ボードを使用する場合：300us）
→取込み時間が変化します。

• TriggerメニューのAdvancedタブを開き、Trigger Positionの
“Auto”のチェックを外し、50％から任意の値に変更します
→Tのマークの位置が変わります。

1. トリガ機能操作手順 2/2

横軸：時間

縦軸：振幅
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参考：Time Overview Analysis（解析）時間長の操作

Analysis オフセット
Analysis 時間長

他の画面で使用する解析の時間長（領
域）を指定します。スペクトログラム表示
画面や復調画面などの、他のすべての
xxx vs Timeの画面の時間長です

画面上部のBLUEバーで、その長さを
確認することができます

数値はフロントパネルやキーボードでの
入力の他に、マウスでのエッジドラグや
マウスのホイールも使用できます

“T”表示はトリガの位置を示します

下のPINKのバーは、各解析画面をクリックした際、
その画面で実際に計算に用いられる時間長（領域）を示します

Time Overviewの画面は “時間軸の一覧表示”です。信号の振幅 vs 時間表示や解析
(Analysis)の時間長などをまとめて表示しています

Analysis時間長(BLUEバー)の長さをSpectrum時間長(REDバー)のデフォ

ルト長の2倍以上にすると、スペクトログラムで時間軸ズーム・イ

ン(FFTオーバーラップ)ができるようになります

ScaleはAcquisition（取込）の時間を示します
(MDO4000のRF取込時間に相当)

このプルダウン・メニューで
”Analysis”を選択することで、
Analysis時間長を設定できます

黒背景プロット・エリアの黄線は、入力信号の
“取込帯域幅全体でのパワー”vs時間表示です
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参考：Time Overview Spectrum時間長の操作

Spectrum オフセット
Spectrum 時間長

スペクトラム表示画面の計算で使用される時間長と時間
領域を示しており、 REDのバーで示されます

値の入力/変更は；

フロントパネルやキーボードでの数値入力の他に、マウ
スでのエッジドラグやマウスのホイールも使用できます

注意： Spectrum 時間長

•デフォルト(Auto)の Spectrum 時間長は固定値ではなくRBW, FFTウィンドウで変わります。
RBWを狭くするとSpectrum計算時間長は長くなります

•Spectrum時間長や時間領域を変更して、再計算表示するときは、Replayアイコンをクリックします

•ここで設定したSpectrum時間長は、Spectrogramには反映されません。（Spectrogramウインドウのスペクトラムの
時間分解能は、ここの設定にかかわらずデフォルト(Auto)のSpectrum時間長が適用されます）

Spectrum時間長は、 REDのバーで表されます
Spectrum画面ではこのREDのバーが示す時間領域でのスペク
トラムが黄色いトレースで表示されています
このREDのバーのOffsetを動かすことで、どの時間でのスペ
クトラムを表示するか、変えることができます

このプルダウン・メニューで”Spectrum”を選択することで、
Spectrum時間長を設定できます
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• “General Signal Viewing”カテゴリから、振幅/周波数/位相/RF I&Qの
時間変化プロット画面を呼び出すことができます

• “Amplitude vs Time”表示は、”Time Overview”の振幅対時間表示と
異なり、帯域制限をかけることもできます

参考：振幅/周波数/位相対時間測定

振幅 周波数 位相 I/Q
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2. スペクトログラム測定

スペクトログラム概念図上図：スペクトログラムとマーカー表示
横軸：周波数、縦軸：時間
色合い：振幅（赤：高レベル、青：低レベル）

下図：マーカー点のスペクトラムを表示

 スペクトラムの時間変動を3D表示
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 ここにOverlapと表示される時は
FFTオーバーラップを行い
拡大表示していることを意味します

 ここをクリックして数値を指定することで、
時間軸ズーム・イン/アウトができます
– 時間軸ズーム・イン(FFTオーバーラップ)するには、

Analysis Lengthの設定値をSpectrum Lengthの
設定値の2倍以上にする必要があります

 3-Dで3次元表示に切り替わります

 スクロールバーも使用できます

 Autoscaleのクリックで、自動で
色・スケール調整がされます

 手動で色調整する場合は、SignalVu-PC
画面上部の アイコンをクリックして
設定画面を出し、”Amplitude Scale”タブを
クリックして、”Color”のMax、Min値を
設定します

Time/div

スペクトログラム画面の操作
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※スケール設定を元に戻す場合は、スペクトログラム上で
右クリックをし、”Reset scale”を選びます



 マウス“右クリック”でショートカットメニューが
表示されます

 中心周波数やスパン設定もマウス操作可能

– マウス操作で簡単に快適に、中心周波数や
スパン幅をスキャニングできます

 パンとズームの操作
– クリックとドラグでズームが可能

– “クリック”した位置がアンカーになり

– 上か右方向へのドラグでズーム・イン

– 下か左方向へのドラグでズーム・アウト

 Reset scale

– スケール設定を元に戻します

 マーカ操作
– マウスで選択したマーカが操作対象になる

 このズーム・イン/アウトの操作は、
スペクトラム画面やTime Overview画面など、
ほぼすべての画面で使用可能です

ポインタを
元に戻す

ズームイン/アウト操作
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• FFTオーバーラップによる時間軸ズーム・イン

参考：スペクトログラム画面のズーム・イン機能のしくみ
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• をクリックします

• （デモボードを用いる場合、”SPECMON”ランプをONにします）

• 信号源に合わせて中心周波数とスパンを設定します
（デモボードの場合：中心周波数2.445312GHz、スパン40MHz）

• アイコンをクリックし、
“DPX”、”Spectrogram”、”Time Overview”を追加し、”OK”をクリック

• Time Overviewウインドウで、Analysis Length（下図青丸の中）を設定します
デモボードの場合：3ms

• Time Overviewウインドウ右上の アイコンをクリックし、
Time Overviewウインドウの表示を消します

2. スペクトログラム測定操作手順 1/4
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• 画面右上の をクリックして、取込みを一度止めます

• Spectrogramウインドウ内のどこかを一回クリックします

• 画面上部のメニューから、Window > Tile Verticallyを
選択します

◦ →Spectrogramウインドウが左側に大きく拡大されて
表示されます

• 画面上もしくは下の アイコンをクリックし、
Spectrogram Settingsウインドウを出します

• Amplitude Scale

タブに移り、
Color(Power)の
Min: を-80dBmに
設定します

• Settingsウインドウの アイコンをクリック、ウインドウを閉じます

2. スペクトログラム測定操作手順 2/4
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• Spectrumウインドウをクリックした後、
プロットエリア上で右クリックをします

• Add markerをクリックします。

◦ 表示されている全画面にマーカが追加され、

◦ Spectrum画面には新たに赤色のトレースが追加されます

• 画面下のマーカ・ツールバーのDefineをクリックします

• Define Markersウインドウで、MRマーカのAttach to: 設定を
Trace 1からSpectrogramに変更します

◦ Spectrumウインドウのマーカが
黄色いトレース上から赤色のトレース上に
移ります

• Spectrumウインドウの の
チェックを外します

◦ 黄色いトレースが消え、赤色の
Spectrogramトレースのみの表示になります

2. スペクトログラム測定操作手順 3/4
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• Spectrogramウインドウ上でマーカをドラッグして動かします

◦ Spectrum表示画面では、Spectrogramウインドウのマーカの位置の時間での
スペクトラムを表示します

• SpectrogramウインドウのTime/divの値を小さくしていきます

◦ 拡大表示されます

2. スペクトログラム測定操作手順 4/4

26



 振幅変調 (AM) AMラジオ、航空無線等

 周波数変調 (FM) FMラジオ、車両レーダー等

 位相変調 (PM) アマチュア無線等

440Hz(ラの音)
人間の可聴域は15Hz～20kHz
犬は60kHz,コウモリは150kHz 

594kHzのキャリア
NHK第一

440Hz(ラの音)

80MHzのキャリア
FM東京

14MHz, 430MHz等のキャリア
440Hz(ラの音)

＋ ＝

＋ ＝

キャリアの振幅を変化

キャリアの周波数を変化

キャリアの位相を変化

＋ ＝

AM: Amplitude Modulation
FM: Frequency Modulation
PM: Phase Modulation

3. アナログ変調解析
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AM復調

FM復調

周波数偏移値

周波数エラー

AM変調度

3. アナログ変調解析
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• をクリックします
（デモボードを用いる場合、
”AM”もしくは”FM”のどちらかを点灯）

• 信号源に合わせて中心周波数と
スパンを設定します
（デモ・ボードの場合：
中心周波数2.445312GHz, スパン1MHz ）

• アイコンをクリックし、”Analog Modulation”カテゴリ内から
AM/FM/PMのうち解析したいものを追加します
（デモボードを用いる場合、AMを選択した場合AMを、
FMを選択した場合FMをお選びください）

• AM/FM/PMウインドウをクリックした後、 アイコンをクリックします

• Pametersタブの
”Measurement BW”の値を
設定します
（デモボードを用いる場合：
1MHz（AM/FMどちらでも））

3. アナログ変調解析操作手順 1/2
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• 画面上部の アイコンをクリックし、Analysis Timeタブの
“Analysis Length”の値を設定します（デモボードの場合：10ms）

◦ Analysis Lengthは、Time Overview画面からのみでなく、
このAnalysis設定ウインドウから設定することもできます

• AM/FM/PMウインドウ左下の”Autoscale”を押し、スケールをあわせます。

• それぞれ変調パラメータを確認できます

3. アナログ変調解析操作手順 2/2
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• RFトランスミッタの測定では、各国や地域ごとの規格によって、
以下をはじめとするパラメータの限度値が定められています

◦ チャネル電力

◦ 隣接チャネル電力比 ( ACPR, Adjacent Channel Power Ratio ) 

◦ 占有帯域幅 ( OBW, Occupied Bandwidth )

◦ スプリアス※

• SignalVu-PCでは、専用のウインドウを用いてそれぞれの測定ができます

※スプリアス測定画面は、操作ガイド基本編 ” 3. EMI Peak測定 ” にて紹介しています

4. チャネル電力 / 隣接チャネル電力比 / 占有帯域幅
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4. チャネル電力 /隣接チャネル電力比測定画面

メイン
チャネル

隣接
チャネル

隣接
チャネル

隣接
チャネル

隣接
チャネル

隣接チャネル
電力比

隣接チャネル
電力比

32

メインチャネルの
平均電力



4. 占有帯域幅測定画面
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占有帯域幅

x dB 帯域幅

その他の結果表示



• をクリックします

◦ デモボードを用いる場合、
”QPSK2”を点灯します
→ W-CDMAを模擬した信号が出ます

• 信号源に合わせて中心周波数、
基準レベルを設定します

◦ デモボードの場合、
中心周波数: 2.445312 GHz、
基準レベル: -10 dBm

• アイコンをクリックし、
”RF Measurements”カテゴリから、
“Chan Pwr and ACPR”と
”Occupied Bandwidth”を選択し、
”OK”ボタンをクリックします
（※”Spectrum”アイコンはRemoveします）

4.チャネル電力 / 隣接チャネル電力比 / 占有帯域幅

操作手順

34



• “Channel Power and ACPR” ウインドウをクリックした後、 アイコンを
クリックします

• SettingsウインドウのMeasurement Paramsタブにて、
Average (平均化) と Channel Filter の設定を確認します

◦ Channel Filterは、準拠する規格による指定がなければ”None”にします
デモボード信号を用いる場合、Channel Filter設定は以下の画像の通りにします

• SettingsウインドウのChannelsタブに移り、
”Number of adjacent Pairs”の値に“2”と入力し、Enterキーを押します

• “Channel Bandwidth”にチャネル幅を、”Channel Spacing”にチャネル間隔を
入力します （デモボードの場合：Bandwidth 3.84MHz、Spacing 5MHz）

4.チャネル電力 / 隣接チャネル電力比 / 占有帯域幅

操作手順
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• “Occupied BW & x dB BW” ウインドウをクリックし、画面下に
Occupied BWの設定ウインドウを出します
（消えている場合は、 をクリックします）

• “Parameters”タブをクリック、設定を確認し、Measurement BWを変更します

◦ デモボード信号の場合は、10 MHzに設定します

4.チャネル電力 / 隣接チャネル電力比 / 占有帯域幅

操作手順
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オプション機能(一部)



• USB RSAシリーズ本体からPCに送られたデジタル・生データを
PCのSSDに連続記録します（ストリーミング記録、標準機能）

• 記録された生データをSignalVu-PC本体で再生できます
（プレイバック機能、オプションSV56が必要です）
プレイバック中は、記録時に表示していなかった測定ウインドウを
新たに追加して測定することも可能です

5. ストリーミング記録＆SV56 プレイバック機能
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5. ストリーミング記録(FreeRun状態)手順

• 信号源は何でも構いません。測定中に設定を行います

• 画面上部の アイコンをクリックすると、Recording設定ウインドウが開きます

• “Record Setup”タブをクリックします

• Location: (ファイル保存場所)とBase filename: (基本ファイル名)を設定します

• Data structure: が”Formatted”になっていることを確認します

• 続いて“Record”タブをクリックします

• Files per run:に、連続保存するファイル数を入力します

• Record Time:にチェックが入っていることを確認し、数値と単位(sec/usec)

を設定します

• Record to disk: で“Record now”になっていることを確認し、Startをクリックします
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5. SV56プレイバック機能(FreeRun状態)手順

• 画面上部の アイコンをクリックします

• 画面下部のRecordingメニューから、”Playback”タブをクリックします

• Location: の”…”をクリックし、出てきたウインドウの右下にあるプルダウン・メニュー

から”ADC sample data (R3F)”を選んだ後、先ほどRecordで保存した.r3fファイルを選び、

ファイルを開きます

• “Play”をクリックします
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参考：生データ(.r3f)とIQデータ(.tiq, .mat)の違い

生データ(.r3f) IQデータ (.tiq, .mat)

各データの内容 112MS/sでサンプリングされ
たデジタル・データ

それぞれ最大56MS/sで
サンプリングされた
I/Qデータ [単位：電圧]

サンプル・レート 112MS/sで固定 スパン幅によって可変

データの取り扱い 一度IQデータへの変換
作業が必要

汎用IQデータとしてMATLAB
などで呼び出して使用可能

記録可能時間 PC内蔵SSDの容量次第
（1秒あたり224MB）

最大1秒間

ヘッダの内容（共通） 中心周波数、基準レベル、サンプル・レート、
アラインメントの有無、トリガ情報など

ヘッダの内容（.r3f） RF入力チャンネルの
振幅/位相補正データ

－
(既に振幅/位相補正済み)
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参考：USB-RSA データ処理ブロック図と保存形式の違い

ADC
RF

ダウン・
コンバータ

USB

3.0

インタ
フェー
ス

PC

メモリ
SW

DDC

PC

メモリ

SW 

DPX

PC

メモリ

SignalVu-PC

ソフトウェア
あるいは

RSA APIを
用いて
組まれた
独自

ソフトウェア

ベースバンドDSPソフトウェア

①IQデータ

②DPX表示

PCRSA306本体

RSA本体

IF信号

③ストリーミング記録生データ
- .r3f (ヘッダ＋生データ)
- .r3h (ヘッダのみ)
- .r3a (生データのみ)

①IQデータ
.tiq, .mat, .csv

②DPX表示のデータ
- DPXスペクトラム（カラー・グレーディング表示）
(画像ファイル、あるいは.dpx)

- DPXスペクトログラム（スペクトラム＆タイム・スタンプ）
(.tiqとして保存可)

112MS/s
デジタル・データ

③ストリーミング記録
生データ
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補足資料



1. DPXスペクトログラム(.TIQファイル)の保存

2. 保存したDPXスペクトログラム(.TIQファイル)の呼出

3. リプレイ機能

4. DPXスペクトログラム csv形式での保存
(全体)

5. DPXスペクトログラム csv形式での保存
(一部)

補足資料目次
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1. 画面右上のStopアイコンをクリックして、取込を停止します
2. 画面上部メニューバーから、File > Save As をクリックします
3. 保存形式の選択で、Acq data with setup (TIQ)を選択し、ファイル名を入力、

”Save”をクリックします
4. 次に出てくる画面で、下画面のようにセッティングを行います

1. DPXスペクトログラム(.TIQファイル)の保存

データ・タイプの指定：
・DPX spectra
(DPXスペクトログラム・データのみ)
もしくは
・Both IQ and DPX
(時間軸IQデータ＋
DPXスペクトログラム・データ)
を選択

取込1回あたりのIQデータのうち、
どの長さだけ保存するか：
・Entire record
(取り込まれたデータ長全体を保存)

複数回取り込まれたデータのうち、
何回分の取込を記録するか：
・All in history
（メモリ内の全ての取込データを記録）
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1. 画面上部の アイコン
をクリック、もしくはメ
ニューバーからFile > Recall

を選択

2. ファイル形式から、Acq

data with setup (TIQ)を選択

3. ファイル名を選択して、ダ
ブルクリックもしくは”開く
(O)”を選択

4. 出てきたウインドウか
ら、”Data and setup”を選ん
で”OK”をクリック

2.保存したDPXスペクトログラム(.TIQファイル)の呼出

ファイル形式選択ファイル名選択

46



Replay ツールバーはViewメ

ニューをドロップダウンして
選択表示します

(Runしている時は
表示選択できません。)

ツールバーの “VCR” ボタンは左から順に頭出し,
巻きもどし, 1データ再生, 送り, 終端にスキップ, 
全データ再生、ループ再生（エンドレス）

Replay “ボタン”は、送りやループなどを
指定（選択）することもできます。

Video Cassette Recorder

取り込まれた直後のデータ、もしくは
保存されたTIQファイルの
リプレイを行うことができます

3. リプレイ機能
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 Replayの対象を選択します（２種類あります）
① Acq Data: 通常のスペクトラム等のReplay

② DPX Spectra: DPXスペクトログラムのReplay
※DPXスペクトラム表示(色付きスペクトラム)の

Replayはできません

 DPXスペクトログラムの画面上の青矢印を
ドラッグ＆ドロップすることで、リプレイの
startとstopの位置を指定することができます

 リプレイ・ツールバーの をクリックすると
出てくるReplay設定画面からも、Replay対象や
start/stop位置の指定ができます

DPXスペクトログラムの場合、
右側の“Select DPX
Spectra”タブから

設定

3. リプレイ機能（続き）
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1. 画面上部メニューバーから、File > Save Asを選択
2. ファイル形式選択から、Acq data export (CSV)を選択し、
ファイル名を入力、”Save”をクリック

3. 出てきたメニューから、以下のように選択し、”Save”をクリックします
4. DPXスペクトログラムの各時刻でのスペクトラムが数値データで
出力されます
※周波数軸情報は出力されません

4. DPXスペクトログラム csv形式での保存(全体)
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1. DPXスペクトログラムの全体ではなく、一部を切り出してcsv保存することもできます

2. DPXスペクトログラム画面上の青矢印(左下図)、もしくはリプレイ・ツールバーの
をクリックして出てくるリプレイ設定画面から、セーブしたい範囲を

指定します。

3. 画面上部メニューバーからFile > Save AsをクリックしてSave画面を出し、
ファイル形式選択から、Acq data export (CSV)を選択し、ファイル名を入力、
”Save”をクリックします

4. 出てきたメニューから、右下図のように選択し、”Save”をクリックします

5. DPXスペクトログラム csv形式での保存(一部)
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オプション機能は、応用編その2をご参照ください

 応用編その1

 基本操作のおさらい

 標準機能

1. トリガ機能

2. スペクトログラム測定

3. アナログ変調解析

4. チャネル電力 / 

隣接チャネル電力比(ACPR) / 

占有帯域幅(OBW)

 オプション機能(一部)

5. ストリーミング記録と

SV56 プレイバック機能

 補足資料

 応用編その2

 オプション機能

6. SVM 汎用デジタル変調解析

7. SV23/24/25無線LAN解析

• 参考：SV27 Bluetooth解析

8. SVP RFパルス解析

9. SVA オーディオ解析

10. SVT セトリング時間解析

11. SV54 信号識別/分類機能
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操作に関するご不明点、疑問点などございましたら、
以下フリーダイヤルまでお気軽にお問い合わせください。

---------------Tektronix/Keithleyお客様コールセンター-------------

電話番号：0120-441-046（フリーダイヤルヨッ！良いオシロ）
営業時間：平日9:00～12:00、13:00～18:00

--------------------------------------------------------------------------------

上記フリーダイヤルで、以下すべてお受けしております
1：修理・校正

2：製品及び技術的な質問
3：購入及び価格・納期

4：営業担当へのコンタクト

お客様コールセンターのご案内
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Twitter @tektronix_jp
Facebook http://www.facebook.com/tektronix.jp

本テキストの無断複製・転載を禁じます

株式会社TFF テクトロニクス/ケースレーインスツルメンツ

Copyright © Tektronix, Keithley Instruments.

All rights reserved.

www.tektronix.com/ja

www.keithley.jp/

Thank you
for your attendance!
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